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1 Getting Started

About this guide
Welcome to Inspiration® 6, the premier tool to develop ideas
and organize thinking. This guide is intended to get you started
using Inspiration quickly and easily. This guide contains:
♦ What’s new in Inspiration 6!
♦ System requirements.
♦ Installation instructions.
♦ Customer service information.
♦ An overview of what Inspiration is and how you can use it to
develop and clarify your ideas and concepts.
♦ A short step-by-step tutorial that shows you how to use the
Inspiration tools and commands to create a diagram and
outline.
♦ A guide to Inspiration templates. Templates are starter
documents and worksheets you can use to jumpstart your
diagrams and outlines.

Where to find more information
The Inspiration Help system contains detailed information
about using Inspiration commands and features. The Inspiration
User’s Manual on the CD-ROM contains all the information in
the Help system.
♦ To access online Help while you are using Inspiration,
choose Inspiration Help on the Help menu.
♦ To view or print the User’s Manual see “Viewing and
printing the Inspiration User’s Manual on the CD-ROM”
later in this guide.
Getting Started
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What’s new in Inspiration® 6!
Inspiration includes the following improvements and new
features:
URL Hyperlinks—Connect to the Internet directly from
Inspiration! With Inspiration 6, you can create hyperlinks to
connect to resources on the World Wide Web. You can simply
type a Web address to create a hyperlink or you can assign a
Web address to selected text using the Internet command on the
Utility menu. Clicking on an active hyperlink starts your
browser and opens the Web address. When you export an
Inspiration document to HTML, hyperlinks are also active in
the exported file.
Expanded and enhanced symbol libraries—Inspiration 6
has over 1,250 colorful, high-resolution symbols, including
several hundred photographic quality images. Symbol libraries
are organized into subject categories, making the process of
finding a symbol quick and easy. Click the down arrow
on the
Symbol palette to see the categories and associated libraries.
Internet graphic support—The growth of the Internet has
brought two graphics standards to the forefront—JPG and GIF.
Inspiration 6 lets you create symbols using both of these
formats, as well as BMP, WMF and PICT.
Simplified graphics importing and symbol creation—It’s
easy to add your own graphics and symbols in Inspiration 6. You
can drag and drop a graphic directly from another program onto
your Inspiration document or the Symbol palette. You can also
import graphics directly into the symbol libraries using the
improved Edit Symbol Library feature.
Animated symbols—Inspiration 6 includes support for
animated symbols, and a select number of animated symbols are
included in the symbol libraries. You can also import your own
animated GIF files. An Application Properties setting lets you
turn this feature on or off. With the feature turned off,
Inspiration displays only the first frame of the animation.
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Multicolor symbols—Personalize multicolor symbols using the
new Multicolor button
on the Draw toolbar. Click the
Multicolor button to display the colors used in a selected symbol
and choose new colors.
Reinstallation of symbols—With Inspiration 6, you can now
add an existing symbol to your diagram, manipulate it, add draw
elements, combine it with other symbols, and reinstall it in a
symbol library as a new symbol.
Frame enhanced symbols—You can now add (or remove) a
rectangular frame to any symbol. Choose Frame on the Symbol
menu to add or remove a frame.
More templates—Inspiration 6 has twice as many templates to
help you get started. Subject categories include language arts,
science, social studies, teacher planning and thinking tools.
Webbing Arrange—Use this feature to arrange your diagram
in a web with the main idea at the center and related ideas
radiating outward. This feature is great for story webs, character
webs and other related diagrams.
Size By Level Arrange option—The Size By Level arrange
option enhances visual learning by emphasizing levels through
symbol size. Symbols at each level in the diagram are sized
equivalently, with symbols at the top of the hierarchy sized
larger and subsequent levels sized smaller. You can apply this
feature to all arrange types using the Size By Level check box in
the Arrange dialog box.
Picture-to-Topic—This feature helps the transition from a
diagram to an outline by associating a word with the symbol
image. To use this feature, add several symbols to your diagram,
then click the Outline button to switch to Outline view. The
symbol labels appear as topic text. When you return to Diagram
view, the text now appears in the symbols. You can turn this
feature off using the Picture-to-Topic option in Application
Properties.
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Checklist—This feature makes Inspiration 6 a more powerful
tool for project planning and tracking tasks. As you work on a
document, you can check off completed items in Diagram or
Outline view. In Outline view, a check box appears to the left of
each topic. In Diagram view, a check box appears in the lower
right corner of each symbol. To turn on Checklist mode, choose
Show Checklist on the Utility menu.
Notes List—In Inspiration 6, notes you add to your diagram are
automatically printed as a separate document when you print
your diagram. You can turn this feature off using the Print Notes
List check box in Print Options. You can also view and modify
all the notes for your diagram by choosing Notes List on the
View menu.
Selective Text color—In Inspiration 6, you can now select
text in a symbol or outline topic and change its color. In
Diagram view, use the Text Color button on the Draw toolbar to
change the color of selected text. In Outline view, choose Text
Color on the Effect menu.
Continuous nudge—Click a nudge button (up, down, right,
left) without releasing the mouse button to continuously nudge a
selected symbol or draw object.
Outline View cursor tracking—When you move the cursor
to the left of a topic in Outline view the pointer looks like
this
. The pointer change makes it easier to find the right
spot to grab the topic you want to move.
Expanded Help system—Inspiration 6 includes a fully indexed
and searchable Help system.
Resize symbols from any corner—You can now size symbols
from all four corners of a selected symbol.
Spell check button on the Diagram and Outline
toolbars—You can now check the spelling in your documents
using the new Spell button on the Diagram or Outline toolbar.
Note that the Properties tool has been removed from the
Outline toolbar; and the Symbol tool has been removed from the
Diagram toolbar.
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Background colors included in diagram exports —
Inspiration 6 exports the background color of your diagram.
Now when you export your diagram, what you see in Inspiration
is what appears in the exported document.
Measurement options—You can now set measurements for
the grid and rulers to inches or centimeters using a setting in
Application Properties.
New Line/New Topic settings—Application Properties
settings allow you to control Enter (Return) key functions when
you add notes and new topics.
Grid square selection—With Grid Snap on (choose Grid Snap
on the Utility menu), the pointer remains a crosshair +, rather
than selecting a grid square. To change the size of the grid
squares, choose Diagram Properties on the File menu. Click the
Options tab, and then enter values for Grid Height and Grid
Width.
User friendly default settings—You have asked us to change
some of our defaults. The default for Grid snap and Page lines is
now off. In Print Options, the default for printing is now Fit to
1 Page; the default for printing notes text in Diagram view is on.
In Windows®, the default symbol is now an oval (like the
Macintosh®).
For more information about the new features in Inspiration 6,
choose Inspiration Help on the Help menu.
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Installing Inspiration
System Requirements
Before you install Inspiration, make sure your computer meets
the following minimum requirements:

Macintosh® computers
♦ Macintosh or Power Macintosh
♦ System 7.0, or later (System 7.6 is required to use the
Internet features)
♦ 2 MB available RAM
♦ 640 x 480 display; 16 colors or more
♦ 30 MB available hard disk space for full install, including
symbols, templates, examples and Help (5 MB minimum for
custom install with selected components)
♦ CD-ROM drive
♦ Internet browser, optional (A browser is required to use the
Internet features.)
♦ Macintosh compatible printer (B/W or color), optional
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Microsoft® Windows computers
♦ 486 processor (or equivalent) or higher
♦ Windows 95/98™ or NT 4.0, or later
♦ 8 MB RAM
♦ VGA, Super VGA or other Windows compatible graphics card
♦ 20 MB available hard disk space for full install, including
symbols, templates, examples and Help (5 MB for custom
install with selected components)
♦ CD-ROM drive
♦ Internet browser, optional (A browser is required to use the
Internet features)
♦ Windows compatible printer (B/W or color), optional

About upgrading from an earlier version of
Inspiration
When you install Inspiration 6, it does not overwrite any earlier
version of Inspiration installed on your computer. This enables
you to keep custom templates and custom symbol libraries
created in the earlier version of Inspiration.
After you install Inspiration 6, you can copy custom templates
and symbol libraries from the earlier version of Inspiration to
the Inspiration 6 folder.
Copy symbol libraries from the earlier version of Inspiration to
a folder inside the Inspiration Libraries 6 folder. You can copy
the libraries to an existing folder or to a folder you create. For
example, you could create a new folder called “Inspiration 5
Symbols.”
Copy templates from the earlier version of Inspiration to the
Inspiration Templates folder inside the Inspiration 6 folder.
After you copy the templates and libraries you want to keep,
you can remove the earlier version of Inspiration from your
computer.
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Any files you created with an earlier version of Inspiration can
be opened by Inspiration 6; however, after you open a file in
Inspiration 6, it cannot be opened in the earlier version of
Inspiration.

Macintosh installation
The following instructions explain how to install Inspiration for
use on a single Macintosh. For network installations, refer to the
network installation instructions provided with your site license.
Note… Site licenses and network licenses are available from
Inspiration Software, Inc. For more information, please call
(503) 297-3004.
⇒ To install Inspiration on a Macintosh
Before installing, be sure to turn off any anti-virus software.
1

Insert the Inspiration CD-ROM into the CD-ROM drive.

2

Double-click the Inspiration 6 Install icon that appears on
the CD-ROM.

3

Read the Welcome dialog box, and then click Continue.

4

On the drop-down menu, choose Easy Install or Custom
Install.
♦ Choose Easy Install to install the full Inspiration
application, including symbols, templates, examples and
Help.
♦ Choose Custom Install to selectively install symbols,
templates, examples and Help. Choose this option if you
have limited hard drive space available, and you do not
want to install the full Inspiration application.
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5

Choose the Install location by selecting the drive and folder
in which you wish to install Inspiration.

6

Click Install.
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Click Quit when the installation is complete.

Note… You can exit the installation process at any time by
clicking Cancel.
Inspiration starts automatically following installation. To begin
using Inspiration, see “Personalizing Inspiration” later in this
guide.

Windows installation
The following instructions explain how to install Inspiration for
use on a single computer. For network installations, refer to the
network installation instructions provided with your site license.
Note… Site licenses and network licenses are available from
Inspiration Software, Inc. For more information, please call
(503) 297-3004.
⇒ To install Inspiration in Windows
Before installing, be sure to turn off any anti-virus software.
1

Insert the Inspiration CD-ROM into the CD-ROM drive.

2

On the desktop, double-click My Computer.

3

In My Computer, double-click the CD-ROM icon.

4

Double-click the Install.exe icon.

5

Read the Welcome dialog box, and then click Next.

6

Enter a location for your Inspiration folder, and then click
Next.

Note… Inspiration automatically chooses the C drive of your
computer, but you can specify another drive.

Getting Started
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7

Choose Easy Install or Custom Install, and then click Next.
♦ Choose Easy Install to install the full Inspiration
application, including symbols, templates, examples and
Help.
♦ Choose Custom Install to selectively install symbols,
templates, examples and Help. Choose this option if you
have limited hard drive space available, and you do not
want to install the full Inspiration application.

8

Follow the instructions on your screen to complete the
installation process. A message appears when installation is
complete.

Note… You can exit the installation process at any time by
clicking Cancel.
Inspiration starts automatically following installation. To begin
using Inspiration, see “Personalizing Inspiration” later in this
guide.
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Personalizing Inspiration
Before you begin using Inspiration, you need to personalize it by
entering your name, organization and serial number.
⇒ To personalize your copy of Inspiration
1

When installation is complete, Inspiration starts
automatically.
The Personalize Inspiration dialog appears.

2

Enter your name in the Name box.
—And/Or—
Click in the School/Organization box, then enter the name
of your school or organization.

3

Click in the Serial Number box, then enter your serial
number.
The serial number identifies your copy of Inspiration; it is
required to personalize your Inspiration application.

Note… Your serial number can be found on the CD-ROM sleeve.
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Check the Name, Organization and Serial Number boxes
carefully to be sure you have entered the information
correctly. To make changes, click in the box you want to
change and edit the information.

5

Click OK to personalize your copy of Inspiration.

6

To register Inspiration, see “Registering Inspiration” later in
this guide.
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Registering Inspiration
If you purchased a single copy of Inspiration, you can register
online or send in the printed registration card provided.
To register online, click Register Online after you personalize
Inspiration. Your browser starts and opens Inspiration’s online
registration form. Follow the on-screen instructions. (Note…
You must have a modem and a browser installed to register
online.) If you are unable to register online, please complete and
mail the printed registration form.
To register a multiuser license, please send in the printed license
agreement.
When you register, you’re entitled to special benefits from
Inspiration Software, Inc. As a registered customer, here’s what
you get:
♦ Inspiration telephone, fax and e-mail support
♦ Substantial discounts on Inspiration upgrades
♦ Tips on using Inspiration
♦ Information about new products or updates
♦ Inspiration newsletter, featuring articles on creative ways to
use Inspiration
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Viewing and printing the Inspiration User’s
Manual on the CD-ROM
The Inspiration User’s Manual is included on the Inspiration 6
CD-ROM. To view or print the manual, you need Adobe®
Acrobat® Reader installed on your computer. If your computer
does not have Acrobat Reader, you can install it using the install
program on the Inspiration CD-ROM.
⇒ To view or print the Inspiration User’s Manual on a
Macintosh
1

Insert the Inspiration CD-ROM into the CD-ROM drive.

2

Double-click the Manual folder that appears on the CDROM. If Acrobat is already installed on your computer, skip
to step 5.

3

Double-click the Reader Installer icon.

4

Follow the on-screen instructions to complete the
installation process.

5

Double-click the Manual folder to open it. The folder
contains two documents:

6
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GetStart.pdf

This Getting Started Guide, including
installation instructions and tutorial
(approximately 130 pages)

Manual.pdf

Inspiration User’s Manual
(approximately 230 pages)

Double-click a file to view or print it.
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⇒ To view or print the Inspiration User’s Manual in
Windows
1

Insert the Inspiration CD-ROM into the CD-ROM drive.
If Acrobat Reader is already installed on your computer, skip
to step 7.

2

On the desktop, double-click My Computer.

3

In My Computer, double-click the CD-ROM drive icon to
view the contents of the CD-ROM.

4

Double-click the Manual folder to open it.

5

Double-click Acrobat.exe to install Acrobat Reader.

6

Follow the on-screen instructions to complete the
installation process.

7

On the desktop, double-click My Computer, and then
double-click the CD-ROM drive icon to view the contents of
the CD-ROM.

8

Double-click the Manual folder to open it. The folder
contains two documents:

9
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GetStart.pdf

This Getting Started Guide, including
installation information and tutorial
(approximately 130 pages)

Manual.pdf

Inspiration User’s Manual
(approximately 230 pages)

Double-click a file to view or print it.
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About Inspiration customer service
We at Inspiration Software, Inc. are committed to assisting our
customers. If you have comments, questions or need help
working with Inspiration, you can contact us by phone, fax or
e-mail. You can also connect directly to Inspiration Technical
Support by choosing Help on the Web on the Help menu.
Inspiration Software, Inc. provides customer service and
technical support for registered users. Be sure to register so you
can take advantage of our support services.
When you contact us, please provide your serial number. Our
support services are open Monday through Friday from
8 a.m. to 5 p.m. Pacific Time. Our telephone number is
(503) 297-3004. Our Fax number is (503) 297-4676. Our e-mail
address is techsupport@inspiration.com. We look forward to
hearing from you!

Getting Started
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2 Introducing Inspiration

In Inspiration, you think and learn visually. Inspiration provides
you with the tools to create a picture of your ideas or concepts
in the form of a diagram. It also provides an integrated outlining
environment to help you develop your ideas into organized
written documents. Inspiration’s combination of visual and
linear thinking deepens understanding of concepts, increases
memory retention, develops organizational skills and taps
creativity.
When you work with visual representations of ideas, you easily
see how one idea relates to the others. Learning and thinking
become active rather than passive. You discover where your
deepest knowledge lies, and where the gaps in your understanding
are. When you create a visual map of ideas, you can recall the
details better than if you had read a paragraph. That’s because
you can see it in your mind.
If you have an idea that you want to expand, whether it’s an
idea for a written document or to map out a plan, Inspiration
can help you organize your thoughts and save you time. Use the
visual diagramming part of the program to work with your ideas,
to arrange them and group them—in other words, to clarify your
thinking.
When you need a different kind of structure, you can use the
outlining part of the program to organize your ideas in outline
form. Inspiration’s outlining environment is perfect for creating
structure for written documents, speeches and plans.

Introducing Inspiration
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About the Inspiration views
Inspiration has two main views or environments: Diagram view
and Outline view. As you work, both keep track of your ideas.
Sometimes you will work exclusively in Diagram view to create a
graphical organizer or a map showing how ideas or concepts
interconnect. Other times you will work in Outline view where
you might organize and write a report.
Here’s what Diagram view looks like:
Diagram toolbar
Symbol palette

Draw toolbar

Subconcepts
or subpoints

Starting point, main idea or
central theme
Primary points, events or ideas

The Diagram view window
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And here’s what Outline view looks like:
The main idea appears at the top of the
outline. The supporting topics and
subtopics follow in a hierarchical order.

Outline toolbar

Primary topic
Subtopic
Notes text

The Outline view window

Uses of diagrams
In Inspiration you can create many types of visual diagrams. It
doesn’t matter if you’re planning a project, looking at cause and
effect, or developing your understanding of a complex concept.
The kind of diagram you create in Inspiration depends on the
idea you want to develop. Here are some of the different types
of diagrams you can easily build using Inspiration:

Introducing Inspiration
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Concept map
A concept map is a hierarchical diagram used to represent a set
of concepts beginning with the most general, or most important,
and then working down to more specific detail. Key concepts are
connected by links that have descriptive words on them
explaining the relationship between the concepts. Most concept
maps can be read starting at the main idea and working down the
visual paths.
Concept maps are often used to illustrate scientific or historical
concepts or for other types of knowledge mapping.
Projectiles

are

Objects

that can be

that can be

Shot

Thrown

such as

such as

such as

such as

Bullets

Rockets

Baseball

Golfball

The projectile diagram is an example of a concept map.

24

Inspiration Getting Started

Idea map
Idea mapping is a visual brainstorming technique used to
generate ideas and develop thoughts. An idea map starts with the
main idea or problem in the middle of the screen. You record
ideas associated with the main idea in symbols that radiate out
from the main idea. The symbols connect to the main idea with
links. Sub-ideas or specific details are then added to those ideas.
You let the ideas flow and then step back and look at main
themes, patterns or possible solutions.
Idea maps can be used for individual or group brainstorming,
planning, problem solving, report writing and strategy
development.

The Blue diagram is an example of an idea map.
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Web
A web is a visual map that shows how different bits of
information relate to each other. A web has a main idea or core
concept at the center, with different categories of information
connected to it. Ideas, facts and information are connected to
the categories to support them.
Webbing is particularly useful when you’re analyzing a story or
brainstorming ideas for a plan or written report.

The Secret Garden diagram is an example of a web.

26

Inspiration Getting Started

Storyboard
A storyboard is a visual way to organize projects such as
multimedia presentations or the design of a Web page or site. A
storyboard helps you plan what you’re going to say and show,
and figure out what ideas belong at the beginning, middle and
end. In a storyboard, each symbol can represent a different slide,
screen or page.

My Biography diagram is an example of a storyboard.

Introducing Inspiration
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Uses of Outlines
When you make an outline, you create a hierarchical structure
for a report or plan. An outline helps you organize written
documents, speeches or plans by providing a framework for your
ideas, and by letting you order the flow of information and
structure paragraph detail and contents.
You will find outlining particularly useful for planning and for
structuring your ideas when writing. While the structure of an
outline is simple, outlines can help you organize very complex
material.
Working in Outline view makes it easy for you to see how your
ideas are organized. It’s also easy to arrange your ideas in a
specific order. When you’re writing a report, you can enter your
ideas in your outline, organize them, then write the report by
entering notes text for each idea.
Here are some of the ways you can use outlines:
♦ Creating the structure for written reports and stories
♦ Planning
♦ Organizing notes
♦ Writing instructional material

28
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Opening Inspiration
After you have your copy of Inspiration installed and
personalized, you’re ready to get to work. Here’s how you open
Inspiration.
⇒ To open Inspiration
Here’s how you open Inspiration using MacOS™ or Windows
95/98:
For the MacOS™
♦ Open the folder that contains Inspiration, and then doubleclick the Inspiration icon.

Inspiration icon

For Windows 95/98™
♦ Click the Start button, point to Programs, point to
Inspiration 6, and then click Inspiration.
Inspiration opens and a new, untitled diagram appears on
your screen.
Tip… You can also open a template document to work with.
Templates are starter documents you can use as worksheets or
style sheets. Worksheet templates are like forms with specific
content that you can fill in. Style sheet templates are used to set
up and configure your default Inspiration document to work and
look the way you want it. For more information about
templates, see online Help or the Inspiration User’s Manual on
the CD-ROM. To access Help see “Where to find more
information” earlier in this guide. To view or print the User’s
Manual, see “Viewing and printing the Inspiration User’s
Manual on the CD-ROM” earlier in this guide.

Introducing Inspiration
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3 Learning Inspiration, a tutorial

This chapter contains a tutorial, a quick way to learn to use
Inspiration. Plan on about 35 minutes from start to finish.
If you’re new to Inspiration and if you like to learn while
working on screen, this tutorial is for you. We have kept the
information in small, manageable chunks to make it easy to
learn the basics quickly. Before you know it, you will be using
Inspiration to develop your own ideas and plans!
You use Inspiration the same way you use most MacOS and
Windows programs. As you work, you will use the mouse to drag
objects and to select text, for example. You will also be clicking
and double-clicking, as well as entering information using the
keyboard. If you’re not comfortable doing these things, take a
moment now and refer to the User’s Guide that came with your
computer.

Conventions we used
The tutorial has instructions for both MacOS and Windowsbased computers. When we ask you to press a key or click a
command on a menu, we give the MacOS instructions first, and
then put the Windows instructions in parentheses immediately
afterward. Here are two examples: Press Return (Enter) and
Press the Command (Ctrl) key.
When we ask you to type specific text, what you enter appears
in bold. For example, Family Vacation. When we refer to a
symbol or name you’ve already typed, it appears in italics, like
Family Vacation.
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And a special note…
Because people work in different ways, Inspiration offers lots of
ways to do things—from toolbar buttons to menu commands to
keyboard shortcuts. While these options are all readily available,
in the tutorial we have mostly shown one way to do a task. By
limiting the alternatives we present as you learn how to use the
software, we hope to make it easier for you to learn the task. In
the online Help and the User’s Manual on the CD-ROM, you
will find mention of the many ways you can do each task, so you
can pick the way that’s most comfortable for you. To access
Help, see “Where to find more information” earlier in this
guide. To view or print the User’s Manual on the CD-ROM, see
“Viewing and printing the Inspiration User’s Manual on the CDROM” earlier in this guide.

How we organized the tutorial
In the Inspiration tutorial, you follow a series of straightforward,
step-by-step instructions to create a simple visual representation
of an idea—what we call a diagram. You also work with an
outline, a text-based, hierarchical display of the same idea.
The tutorial is organized in mini-lessons. We designed them to
be completed in order, but you don’t need to do them all at one
time. Each mini-lesson introduces you to one of Inspiration’s
unique features. As you work, you will create a diagram and an
outline. When you finish the tutorial, you will be ready to create
diagrams and outlines of your own.
Let’s get started.
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Mini-lesson 1
in which you get started
In the first mini-lesson, you will open Inspiration. Then you will
enter the main idea for the diagram that you’re creating. Finally,
you will learn how to save your work.

Opening Inspiration
Here’s how you get Inspiration up and running:
For the MacOS
♦ Open the folder that contains Inspiration, then double-click
the Inspiration icon .
For Windows 95/98
♦ Click the Start button, point to Programs, point to
Inspiration 6, then click Inspiration.
Inspiration opens and a new, untitled diagram appears on your
screen.
Note… Inspiration needs to be installed before you can start it. If
you haven’t installed Inspiration on your computer yet, see
“Installing Inspiration” earlier in this guide.
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Introducing the Inspiration screen
Inspiration automatically opens in Diagram view, where you will
do most of your work. As you follow this tutorial, we’ll refer to
various parts of the screen. Here’s what Diagram view looks
like:
The Main Idea symbol is the starting point
for your diagram. You type your main idea in
the symbol, then add connected ideas to it.
The Symbol palette contains
different libraries of idea symbols
you can add to your diagram.

Use the Zoom
buttons to see
more or less of
your diagram.
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Use the tools on the
Diagram toolbar to add
symbols and links to
your diagram, and to
arrange your diagram.

Use the tools on the Draw toolbar to
move symbols, to color text and
symbols, and to draw shapes.
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Entering your main idea or theme
Entering text in the Main Idea symbol is the starting point for
any Inspiration diagram. The main idea or theme for this
tutorial is a common task—picking a place to go for your family
vacation. Since most of us have figured out, or at least dreamed
about, the ideal vacation at some point in our lives, it’s pretty
easy to imagine the steps involved. We call our tutorial Family
Vacation.
To enter your main idea
When you start Inspiration, you’re in Diagram view. The Main
Idea symbol appears in the center of your screen. The
placeholder text, Main Idea, is already selected. All you do is
type.

1

Type your main idea—Family Vacation.

2

Press Shift+Return (Shift+Enter) to end text entry and select
the symbol.

Now you’re ready to save your diagram for the first time.

Saving your work
Whenever you’re developing your ideas in Inspiration, as with
any software program, it’s important to save your work often.
When Inspiration saves your new diagram, it automatically
names the file with your main idea. That means you don’t have
to give your diagram a separate file name—you take care of that
job the moment you start working on your diagram.
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To save your diagram
1

On the File menu, choose Save.
The dialog box appears with your main idea as the name of
the file.
You don’t have to use what you’re calling your main idea as
the file name. You can enter another name if you wish.
Navigate to the folder where you
want to save your diagram.

Enter the name of
your diagram here.

2

If necessary, navigate to the folder in which you want to
save your diagram.

3

Click Save.
Your diagram is saved, and the file name, Family Vacation,
appears on the title bar above your diagram.
You’re now ready to expand your main idea, which you will
do in Mini-lesson 2.
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Mini-lesson 2
in which you begin getting your ideas down
In this mini-lesson, you’re going to add some ideas to help you
and your family go through the process of deciding where you
want to go for your vacation.
When you enter an idea using Inspiration, it appears on your
diagram as an idea symbol. To show how your ideas relate, they
are connected using what we call links.

Links show how ideas relate.
Idea symbols contain related ideas
that explain or support your main idea.

In this mini-lesson, you’re going to learn the following:
♦ How to use the create tools to add symbols
♦ How to use RapidFire™ quick entry to add symbols
♦ How to reposition your diagram in the window
♦ How to zoom out to see more of the diagram in the window
Let’s go.
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Adding ideas to your diagram
As part of our planning, we’re going to enter what each family
member wants to do on vacation. First, we’ll add the idea
symbol, What we want to do. Then we’ll add an idea symbol for
Mom.
Use the Create tool to add a related idea
1

With Family Vacation selected, on the Diagram toolbar,
position the pointer over the Down arrow on the horizontal
and vertical Create button.

Horizontal and vertical Create button

When you point to an arrow on the Create button, it is
highlighted to show you the direction in which the new idea
symbol will be created.
2

Click the Down arrow.
The new symbol appears connected to and below the Family
Vacation symbol.

As soon as you create a new symbol, you can enter text in it.

3
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Type What we want to do.
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Add idea symbols to represent Mom and Dad
In order to enter what everyone wants to do, we’ll begin by
adding the family members to the diagram below the idea
symbol, What we want to do. This time we’ll use the diagonal
Create button.
1

On the Diagram toolbar, position the pointer over the
Lower Right Diagonal arrow on the diagonal Create button.

Diagonal Create button

2

Click the Lower Right Diagonal arrow.
The new symbol appears connected to and diagonally below
the What we want to do symbol.

3

Type Mom.

4

Press Shift+Return (Shift+Enter) to end text entry.

5

Select What we want to do.

6

Click the Lower Left Diagonal arrow.

7

Type Dad.

8

Press Shift+Return (Shift+Enter) to end text entry.
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Let’s take a look at what you’ve created so far:
You started with the Main idea…

…then added a related idea…

… and then added
another related idea.

40

… then added another
related idea…
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Use the RapidFire™ tool to get Mom’s preferences
down quickly
We’re going to use Inspiration’s RapidFire tool to enter the
things Mom wants to do while on vacation. You use RapidFire
when you want to brainstorm, capturing your ideas quickly
without worrying about their order. You add ideas right into the
selected symbol and let Inspiration create symbols and place
them for you.
1

Click the Mom symbol to select it. On the Diagram toolbar,
click the RapidFire button.

RapidFire button

The RapidFire icon appears in the symbol to show you the
tool is turned on. You’re ready to begin typing ideas.
2

Type Sun, then press Return (Enter).
Once you start working in RapidFire, you use the Return
(Enter) key to separate your ideas.

3

Type Scuba.

4

Click the RapidFire button to turn it off.
Inspiration places your new symbols in the diagram after you
type your ideas and press Return (Enter).
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Now let’s add Dad’s preferences
1

First, select Dad and drag him to the left two inches to give
yourself more space to work with.

2

With Dad selected, on the Diagram toolbar, click the
RapidFire button.

RapidFire button

The RapidFire icon appears in the symbol to show you the
tool is turned on. You’re ready to begin typing ideas.
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3

Type Play golf, then press Return (Enter).

4

Type Fish.

5

Click the RapidFire button to turn it off.
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Now let’s take a look at your work
Here’s what your diagram looks like so far.

RapidFire places your ideas in a freeform structure. You don’t
need to think about organizing your ideas yet—you’re still
getting them down so you can ‘see’ what you think. We’ll learn
about organizing the diagram later in this tutorial.
Aside… If you see that you’ve made a mistake while typing text
in a symbol, don’t worry. It’s easy to fix. Double-click the text
in the symbol, then select the words you want to change and
type over them. You can also insert text by clicking where you
want to make the correction and entering the new text.
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Changing the view scale
It’s helpful to zoom in and out when you’re working on your
diagram. Sometimes you want to take a closer look at a section;
at other times, you want to see more of your diagram in the
window.
Here, we’ll use the Zoom Out button to see more of the diagram
in the window.
Zoom out to show more of the diagram
♦ On the scroll bar at the bottom left of the window, click the
Zoom Out button.
Zoom Out shows more of the diagram.
Zoom In makes the diagram larger.
The Percentage box lets you select a
percentage at which to view your diagram.

The Zoom Out button makes symbols smaller and gives you
more room to work on the entire diagram. The Zoom In
button makes symbols larger and easy to read. You can zoom
to an exact percentage by clicking the percentage box to the
left of the zoom buttons and selecting the percentage you
want from the submenu.
Tip…There are also keyboard commands for Zoom Out and
Zoom In. If you like using keyboard commands, you will find
many shortcuts on the menus next to the commands. For a list
of keyboard shortcuts, refer to online Help or the Inspiration
User’s Manual on the Inspiration CD-ROM.
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Moving the diagram around in the window
The Position tool lets you reposition your diagram in the
window. It’s especially useful when you want to work on a
section of your diagram that’s at the bottom and you also want
some space where you can add new idea symbols.
Let’s move the diagram up and to the right so that the What we
want to do symbol is just showing at the top of the window and
there’s an open area in the window to the left of the diagram.
1

, then
On the Diagram toolbar, click the Position button
click and drag the diagram so that What we want to do is just
showing at the top of the window.
You can move the diagram as many times as you need to
until you can see the part you want to work in.

2

Click the Position button again to turn it off.

Take a moment to save your work
We’ll remind you every now and then to save the work you’ve
done on your diagram. It’s always a good idea to save frequently.
♦ To save your work, choose Save on the File menu.
You’re now well on your way to completing a diagram of your
ideas. In the next mini-lesson, you will complete your diagram
about your family vacation.
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Mini-lesson 3
in which you complete your diagram
In this mini-lesson, you’re going to finish making your vacation
diagram as you learn each of these procedures:
♦ How to use drag and drop to add a symbol from the Symbol
palette
♦ How to use point and type to add an unconnected symbol
♦ How to link symbols
♦ How to add text on a link
♦ How to move symbols in the diagram
♦ How to change the shape of symbols
Use drag and drop to add a specific symbol
Inspiration has hundreds of symbols you can use in your diagram.
Here, we’ll add one of the six basic symbols, the rounded
rectangle, to the diagram using drag and drop.
1

On the Symbol palette, locate the rounded rectangle symbol.

When you point to a
symbol, a preview
appears next to the
Symbol palette.

2
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Click and drag the symbol until it’s positioned below the
Fish symbol and slightly to the left, then release the mouse
button.
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When you add a symbol using drag and drop, the symbol is
not connected to any other symbols. You can link it later
using the Link tool on the Diagram toolbar.

Here’s where you added the
rounded rectangle.

3

Type Marlin in the new rounded rectangle symbol.

Use point and type to add an unconnected idea
Sometimes when you’re working, you want to add an idea, but
you’re not sure right away where it fits. You can easily add an
unconnected idea anywhere on the diagram without being
concerned about how it relates to the other ideas, using
Inspiration’s point and type method.
For now, let’s add an idea symbol on the diagram to represent
Sarah, another member of the family.
1

Click in the open area on your diagram under the Scuba
symbol, then type Sarah.
A symbol pops up to hold the Sarah text. The symbol isn’t
linked to any other symbol.
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2

Click away from the Sarah symbol to deselect it.

Link the unconnected symbols to show how they
relate to other ideas
Link the What we want to do symbol to the Sarah symbol so
that we can also include Sarah’s ideas in our planning. To show
that Fish and Marlin are related, we’re also going to draw a link
that connects those two idea symbols.
1

On the Diagram toolbar, click the Link button.

Link button

The cursor becomes a two-headed arrow.
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2

Click the What we want to do symbol to tell Inspiration
where you want to draw the link from (the primary symbol).

3

Click the Sarah symbol to indicate where you want to draw
the link to (the secondary symbol).
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The link appears, connecting the primary to the secondary
symbol. The arrow head points to Sarah to show that it’s an
offshoot of the What we want to do idea symbol.

The new link
connects the What
we want to do idea
symbol and the
Sarah idea
symbol.

Now let’s link the other unconnected symbol, Marlin, with
the idea symbol, Fish.
4

Click the Fish symbol to tell Inspiration from where you
want to draw the link (the primary symbol).

5

Click the Marlin symbol to indicate to where you want to
draw the link (the secondary symbol).
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The link appears, connecting the primary to the secondary
symbol. The arrow head points to Marlin to show that it’s
an offshoot of the Fish idea symbol.

6

Click the Link button again to turn it off.

Add text on the link
You can add text on a link to describe the relationship between
the linked ideas. Here, you will add the word for so it’s clear that
the connection is that Dad wants to fish for marlin.
1

Select the link that connects Fish and Marlin, if it isn’t
already selected.
When the link is selected, you see the outline of the text
box that’s associated with that link. It’s ready for you to
begin typing.
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Type for, then click outside on the diagram to deselect the
link.
Now that section of your diagram looks like this:

When you point to a
symbol, the text in the
symbol appears on the
status bar.

Draw toolbar

Tip…It may be hard for you to read the link and symbol text
when you are zoomed out and working in a reduced view. If you
position the cursor over a symbol or link, the text is displayed at
a readable size in the Status bar area at the bottom of your
window.
Move idea symbols around
Moving symbols is easy, and it’s something you will do a lot as
you create diagrams. Here, you will reposition the Marlin symbol
so that it’s a bit lower on the diagram. That way, you can get an
even better view of the text you added to the link to show the
relationship between the ideas.
♦ Click and drag the Marlin symbol down about an inch and
release the mouse button, then click outside on the diagram
to deselect the link.
If you need to move the symbol again to position it to your
satisfaction, just click and drag it again until it’s where you
want it.
Learning Inspiration, a tutorial
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Notice how Inspiration keeps the link connected for you as
you move the symbol. That way, you don’t lose the
connection between ideas when you move them around on
your diagram.
Here’s what that section of the diagram looks like now:

Change the symbol shapes for Dad’s ideas
Here, we’ll make a section of the diagram stand out by changing
the shape of the symbols. In this case, we’re going to select Dad
and his vacation preferences and change these symbols all at the
same time to make them easy to identify.
1

To select the symbols, hold down the Shift key and click
Dad, Fish and Play golf.

2

On the Symbol palette, click the rounded rectangle symbol.
The selected symbols take on the new shape.
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When you click the Rounded Rectangle
symbol on the palette, all the selected
symbols take on the new shape.

Finally, save your work once again
♦ On the File menu, choose Save or press Command+S
(Ctrl+S).
Inspiration saves your file and you’re ready to begin the next
mini-lesson.
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Mini-lesson 4
in which you learn about Outline view
Inspiration has two views or environments in which you can
work: Diagram view and Outline view. While you’ve been
working in Diagram view creating a visual diagram, Inspiration
has been working behind the scenes, building an outline of your
work.
In this mini-lesson, you will learn these procedures:
♦ How to add a subtopic
♦ How to add a topic
♦ How to make topics into subtopics
♦ How to add notes text, much as you would do if you were
writing a report
♦ How to hide and show notes and topics
♦ How to move topics around by dragging
♦ How to change the way the outline looks—the prefixes and
the fonts
♦ How to print your outline
It looks like a lot to do, but it only takes a few minutes!
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Organizing your ideas in Outline view
First, switch to Outline view
♦ On the Diagram toolbar, click the Outline button.

Outline button

Your diagram appears as an outline. The idea symbols you
added in Diagram view appear as topics and subtopics. Your
links don’t appear as part of your outline, but they’re
available in Diagram view.

The + next to the Mom
topic indicates the topic
has subtopics.

The – next to the Sarah
topic indicates the topic
has no subtopics.
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Add a subtopic
We’re going to add Swim, which is something Mom also wants
to do on vacation.
1

Select the topic Mom by clicking to the left of the topic
prefix.

Topic prefix

When you select a topic,
a selection rectangle
appears around it.

Click to the left of the
prefix to select the topic.

2

On the Outline toolbar, click the Add Sub button.
A new subtopic is created below Mom. It’s indented one level
in your outline.

3

Type Swim.

The new subtopic, Swim,
appears below the topic,
Mom. It’s indented one level.
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Add a topic
Adding a topic in Outline view is as simple as adding an idea
symbol in Diagram view.
1

Select the topic Sarah by clicking to the left of the topic
prefix.

2

On the Outline toolbar, click the Add Topic button.

Add Topic button

Inspiration inserts a new topic and the cursor moves to the
next line so you’re ready to type.

3

Type Snorkeling.
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Change the level of a topic
In Outline view, you can move a topic to the right or to the left,
changing its level of importance. Snorkeling is something Sarah
really wants to do so lets change the Snorkeling topic to a
subtopic under Sarah.
1

On the Outline toolbar, click the Right button.

Right button

The topic, Snorkeling, moves to the right, so that it’s now a
subtopic to Sarah.

Snorkeling is now a
subtopic to Sarah.

Add notes text to a topic
Adding notes text is a good way to get the details down about
your ideas and develop your outline into a complete written
document.
Let’s add a note to the topic, Snorkeling.
1

With Snorkeling selected, press Return (Enter).
The cursor moves to a new line so you can type in your
notes.

When you select a topic and press
Return (Enter), a cursor appears below
the topic where you can add notes text.
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Type Sarah would like to go out in a boat to do this.

Each topic can have notes that extend from one line to many
paragraphs of information. If you add notes to your topics, you
will end up with a written report when you finish.
Whenever you add notes text to a topic, Inspiration puts an
outline around the + or - in front of the prefix. It looks like this.

Notes text indicator

Tip…You can also add notes text by selecting a topic and
clicking the Add Note button on the Outline toolbar.

Learning Inspiration, a tutorial

59

Hiding and showing notes text
Sometimes you want to hide your notes text so you can see the
outline structure more clearly. You can work with your notes
text showing, or you can hide it.
First hide your notes text
1

Select the topic, Snorkeling.

2

With Snorkeling selected, on the Outline toolbar, click the
Show/Hide Note button.

Show/Hide Note button

Inspiration hides your notes, so that only the outline topic is
showing.
3

With Snorkeling still selected, on the Outline toolbar, click
the +-Note button again.
Inspiration shows your notes on screen.

Tip… Here’s a shortcut you can use to hide and show
notes—just double-click the outlined + or - next to the topic. If
the notes are showing, Inspiration hides them; if they’re hidden,
Inspiration displays them.
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Hiding subtopics
Just as you can hide and show notes text, you can hide and show
subtopics. By hiding the detail in your outline it is easier to see
its overall structure. We’ll hide the subtopics for the Dad topic.
1

Click to the left of Dad to select the topic.

2

On the Outline toolbar, click the Show/Hide Sub button.

Show/Hide Sub button

Inspiration hides the subtopics for the selected topic, so
there’s less detail showing on your outline.
3

On the Outline toolbar, click the Show/Hide Sub button again
to show the subtopics.

Tip... Here’s a shortcut you can use to hide and show
subtopics—just double-click to the left of the topic prefix.

Moving topics around
Inspiration has lots of ways to organize your topics. One of the
easiest is to drag topics and place them where you want them.
Here, you will move Sarah so that it appears above Mom.
1

Select the topic Sarah by clicking to the left of the topic
prefix.
Note that the pointer looks like this
to the left of the topic.

2

when you move it

Hold the mouse button down and drag the topic, Sarah, up in
your outline until it covers the topic Mom.
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As you drag the topic, a dotted rectangle follows the pointer.

3

When the dotted rectangle covers the topic above which you
want to insert Sarah, release the mouse button.
Sarah and its subtopic appear above Mom and below What
we want to do on the outline.
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Changing the prefixes for your outline
Everyone has preferences about how things look. For example,
you may want to change the kind of prefixes that appear in
front of the topics on your outline. It’s easy to do. Here we’ll
change from Roman Numeral (the way prefixes are when you
first start Inspiration) to an alphanumeric set of prefixes.
♦ On the Outline toolbar, click the Prefix button, then choose
AlphaNumerals.
Inspiration changes all the prefixes on your outline.

You changed from
the Roman
Numeral prefixes…
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…to the alphanumeric
prefixes.
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Changing the way your outline looks
One of the things you will probably want to do is change the
fonts and styles you use in your outline. You make these and
other changes, such as setting margins, headers and footers, using
Outline Properties. You can access Outline Properties by
choosing Outline Properties on the File menu.
First, open the Outline Properties dialog box
♦ On the File menu, choose Outline Properties.
The Outline Properties dialog box appears.
Now choose the font you want to use for your outline
1

On the Topic Font tab, click All Items.

2

On the Font drop-down menu, select the font you want to
use.

3

To change the point size in which the font appears, on the
Size drop-down menu, select the size you want.

And change the font for your headers
1

Click the Header/Footer tab to select it.
Inspiration brings the tab to the front so you can work on it.

2

Click the Header Font button.
The Font dialog box appears.
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3

On the Font drop-down menu, select the font you want to
use.

4

Make other changes to size or style, if you wish.

5

Click OK.
You return to the Header/Footer tab.

6

Click OK again to accept your changes and return to your
outline.

You will see all but your header changes on screen. Those you
will see when you preview your outline before you print it, or
when you print.

Printing your outline
When you print your outline, Inspiration automatically includes
all topics, subtopics and notes text. Inspiration also prints a
header at the top of each page. Of course, you can change
what’s to appear in the header or choose to print no header by
changing the settings in the Outline Properties dialog box.
Preview and print your outline
You can preview what your outline is going to look like, and
then print it.
1

On the File menu, choose Print Preview.
Your outline appears on screen so you can see how it will
look on the page. When you position the pointer over the
page, it becomes a magnifying glass .
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Position the magnifying glass
over the area you want to
examine closely, then click.

2

To take a closer look, click on the area you want magnified.
To return to previewing the full page, click again.

3

To print your outline, click Print.

4

When the Print dialog box appears, click Print (OK).
Your outline prints.

Aside... Of course, you can always print directly without looking
at a preview of your document. On the File menu, choose Print.
When the Print dialog box appears, click Print (OK).
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Ready to take a break? Save your changes and close
Inspiration.
If you’re ready to take a break from the tutorial, you can save
your changes, then quit Inspiration. If you want to continue, just
skip this procedure and turn to the next mini-lesson.
1

To close your file and Inspiration, on the File menu, choose
Quit (Exit).
Inspiration asks whether you want to save your changes.

2

Click Yes to save your changes and quit Inspiration.

You can start again with Mini-lesson 5.
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Mini-lesson 5
in which you return to Diagram view
and finish your work
When you return to Diagram view, you will find that the
symbols have changed to reflect the work you did in Outline
view.
In this mini-lesson, you will learn the following:
♦ How to work with notes text in Diagram view
♦ How to change the font for all your symbols
♦ How to set a new default look for new symbols
♦ How to rearrange your diagram into a tree chart
♦ How to change the view scale using Fit To Window
♦ How to change colors for symbols and links
♦ How to change arrow heads
♦ How to print your diagram
First, return to Diagram view
Before you work with the diagram, you need to return to
Diagram view.
Aside... If you quit Inspiration, you need to start the program
and open your document, Family Vacation. Note that
Inspiration always opens in the view you were working in when
you last saved the document.
1

In Outline view, select the topic, Snorkeling, so that it will
be selected and you can find it quickly when you return to
Diagram view.
If the Snorkeling topic isn’t showing on the screen, press
Command+M (Ctrl+M) to select the Main Idea and show the
top portion of your outline in the window. You can then
select Snorkeling.
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To return to Diagram view, click the Diagram button on the
Outline toolbar.

Diagram button

Here’s what your diagram looks like now, including the work you
did in Outline view:

You can see that the new topics you added in Outline view, like
Snorkeling, appear as idea symbols.
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Working with your notes text in Diagram view
In Diagram view, notes text is stored in separate notes windows
attached to idea symbols. Every idea symbol can have notes
text. You can open a notes window at any time to write, to
modify your notes and to read what you’ve written.
To see whether a symbol has notes text associated with it, select
the symbol. If the box in the upper left corner of the symbol is
filled, it means the symbol has notes text.
If the box in the upper left corner is filled,
it means the idea symbol has notes text.

Open the note you wrote in Outline view
1

To display the notes text for Snorkeling, on the Diagram
toolbar, click the Add Note button.

Add Note button

The notes window opens and the note you wrote earlier
appears.
At this point, you can add to or edit your notes, if you want.
Just click in the notes text window where you want to begin
and start typing, or select the words you want to replace and
type over them.
2

When you’re ready to close the notes text window, click the
Close box on the notes text window or, on the File menu,
choose Close.

Tip... You can also open a notes window—whether or not it has
notes in it—by double-clicking the box on the upper left corner
of the selected symbol.
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Changing the font used for your idea symbols
You will want to use your favorite font in your idea symbols.
Let’s select all the symbols and change the font.
1

To select all the symbols on your diagram, on the Edit
menu, choose Select, then choose Symbols.

2

On the Format menu, choose Font, then select the font
you’d like to use.
The text in all the idea symbols changes to the new font.

Tip... You use the same general procedure to change the font for
all your symbols and links at the same time. On the Edit menu,
choose Select All and make your change. To change only the
font you’re using in text on links, on the Edit menu, choose
Select, then choose Links and change the font.

Setting up the default look for new symbols
Now that we have changed the way your idea symbols look, we
can tell Inspiration to use this look for all new symbols we
create.
Let’s start by selecting an idea symbol that already has the shape
and the new font we want to use. Then we’ll set that as the new
look so that the symbol’s characteristics will appear
automatically whenever we create a new symbol. We’ll select
the Play golf symbol since it is the shape, a rounded rectangle,
and the font we want.
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Set a new look for symbols you’re going to create
1

Click the idea symbol, Play golf, to select it.

2

On the Diagram toolbar, click the New Look button.

New Look button

Inspiration sets the new look and shows you a preview.

Tip… If you want to apply the new default look to existing
symbols or links, select the symbols or links and, on the Edit
menu, choose Paste New Look.
Add a new symbol with the new default look
We will add a new symbol off the Main Idea symbol, Family
Vacation. First we’ll select the Main Idea symbol, then create
the symbol.
1

On the keyboard, press Command+M (Ctrl+M) to select the
Main Idea symbol, Family Vacation.

2

On the Diagram toolbar, position the pointer over the Left
arrow on the Horizontal and Vertical Create button.

3

Click the Left arrow to create a new symbol to the left of
Family Vacation.

4

Type Possible places and click outside the symbol to
deselect it.

You will notice the new symbol has the new default attributes.
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Arranging your diagram into a tree chart
The Arrange tool lets you change your diagram into various
kinds of charts. We’ll use the Arrange tool to change the format
of the diagram from a cluster to a top down tree chart.
Display the Arrange Diagram dialog box and make
your choice
1

On the Diagram toolbar, click the Arrange button.
The Arrange dialog box appears.

You can use the Arrange dialog box to straighten up your current
arrangement if you’ve been moving symbols, or to completely rearrange
the way your diagram is structured.
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2

Review the selections in the dialog box.
You’re going to use these default settings:
♦ Entire Diagram is selected.
♦ Under Diagram Type, Top Down Tree is selected.
♦ In the Links drop-down list, Auto-90 is selected.
♦ Under Lowest Level Stacking Models, No Stack is
selected.

3

Click OK.
Inspiration arranges the diagram with the Main Idea symbol
at the top, and the remaining idea symbols in order beneath
it.
Family
Vacation

Possible
places

What we want
to do

Sarah

Snorkeling

Mom

Swim

Sun

Dad

Scuba

Play golf

Fish

for

Marlin
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Resize the diagram so it fits in the window
Let’s change the view scale so that we can see the entire diagram
in the window.
♦ On the scroll bar at the bottom left of the window, click the
Percentage box to the left of the Zoom buttons, then select
Fit To Window.

Click the Zoom percentage box to display the
Zoom menu, then select the percentage you want.

Tip... You can also resize your diagram to fit within the window
by using the Zoom command on the View menu or by pressing
Command+E (Ctrl+E) on the keyboard.
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Using color
Color can help distinguish items on your diagram. You might use
one color to easily identify a group of symbols (Sarah’s vacation
preferences, for instance). You can use the tools on the Draw
toolbar or the commands on the Effect menu.
Change the fill color of the symbols
1

On the Edit menu, choose Select, then choose Symbols to
select all the symbols on your diagram.

2

On the Draw toolbar, click the Fill Color button, then
choose a color you want from the palette.

Fill Color button

Try a light color, such as light red. That lets your text
continue to show up nicely against the symbol’s fill color.
Then change the color of the symbol lines
♦ On the Effect menu, select Line Color, then choose a color
for the line.
Line color affects both the symbol lines and shadow color.
Try a dark red, or another dark color, for contrast.
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Change a symbol to a multicolor symbol shape
1

Click the Sun symbol to select it.

2

On the Symbol palette, click the sun symbol in the Basic
library.

Click the sun symbol in the
Basic symbol library.

The Sun symbol on your diagram changes to the shape of a
sun.
Then change the colors of the multicolor symbol
1

Click the Sun symbol to select it.

2

Click the Multicolor button on the Draw Toolbar, and then
choose colors you want from the palette.

Multicolor button

Try changing the black areas of the sun to a light orange to
give the sun a warm glow.
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Now change the color of the links
1

To select all the links on your diagram, on the Edit menu,
choose Select, then select Links.

2

On the Effect menu, choose Line Color, then select a color
for the links.
Try black, or any dark color that appeals to you.

Now you have a new color scheme for your Family Vacation
diagram.

Changing the arrow heads on the links
While we’re working on the links, let’s change the style of the
arrow heads.
Change the style of the arrow heads
1

On the Link menu, choose Arrow Head Ending Point, then
select your choice.

2

To deselect the links, click on an empty place on your
diagram.

Tip… If you want a different type of link, try the curved links or
other link types on the Link menu.
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You’ve finished your diagram!
Congratulations. You’ve finished creating your Family Vacation
diagram. Let’s take one more look at how your diagram appears
on the screen.
Family
Vacation

What we want
to do

Sarah

Snorkeling

Possible
places

Mom

Swim

Dad

Scuba

Sun

Play golf

Fish
for

Marlin
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Printing your diagram and notes text
Now that you’ve finished your diagram, you can print it.
First preview your diagram
♦ On the File menu, choose Print Preview.
Inspiration shows you what your printed page will look like
so you can return to your diagram and make adjustments if
you wish.
And then print
1

In the Print Preview window, click Print.

2

In the printer dialog box for your printer, make your
choices, then click Print (OK).

When you print your diagram, the notes text for your diagram
prints as a separate document after your diagram prints.
Note…To turn off notes text printing, on the File Menu, choose
Print Options. In the Print Options dialog box, clear the Notes
List check box.

Congratulations!
You’ve now had a quick introduction to some of Inspiration’s
features. You can create a diagram and work on your outline,
change the look, move things around, and lots more.
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Appendix A—Inspiration templates

Following are descriptions of each Inspiration template. To use
a template, choose Template on the File menu.

Inspiration templates
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Language Arts-Character
Example
from the
book

Example
from the
book

Example
from the
book

One of his or her
characteristics
PRIMARY
CHARACTER

Example
from the
book

Example
from the
book

One of his or her
characteristics

Example
from the
book

One of his or her
characteristics
Example
from the
book

Example
from the
book
Example
from the
book

How to use this template
1

Enter character to be analyzed in the symbol labeled
“PRIMARY CHARACTER.”

2

Enter one characteristic in each of the subsymbols.

3

Enter supporting examples in each of the subsymbols.

4

Add characteristic or example symbols as necessary using the
Create or RapidFire tools.

Benefits of using the Character Web template
Character webs represent one of the ways in which visual
learning can support comprehension in the reading process.
Using character webs helps students justify their impressions of
literary characters by citing specific evidence in a given text.
There is also evidence that such an approach can enhance
students’ fiction writing, as they use specific detail to create
richer characters. You may wish to use an amended version of
this web in the social studies curriculum for an analysis of
historical figures. Simply apply examples from the personage's
life or writings.
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Language Arts-Comparison
Similarities

Differences

Differences

Object, Event
or Person

Object, Event
or Person

How to use this template
1

Enter items for comparison in the symbols labeled “Object,
Event or Person.”

2

Enter similarities in the central subsymbols.

3

Enter differences in the symbols to the left and right.

4

Add similarities or differences symbols as necessary using the
Create tools.

Benefits of using the Comparison Web template
One of the most basic and powerful forms of analysis in any
discipline is comparison. This template can be used for simple
comparisons: hero/villain, vertebrate/invertebrate,
democracy/dictatorship and so forth. However, the template
also supports much greater sophistication and complexity,
depending on the subject matter and the user. For example,
students might compare the subtle similarities and differences
between life cycles, literary styles, subcultures and so forth.
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Language Arts-Literary Web

First
Character

Second
Character

Characterization

STORY TITLE
Conflict

Themes

Setting

How to use this template
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1

Enter the title of any work of fiction in the symbol labeled
“STORY TITLE.”

2

Enter appropriate information about characterization,
themes and so forth into the subsymbols.

3

Add symbols to further explain your ideas as necessary using
the Create tools.
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Benefits of using the Literary Web template
Literary webs help students understand a story or novel in terms
of both the whole and its parts. Students can see how the
vocabulary of literature—conflict, theme, setting,
characterization—translates to the reading experience. This web
can also be focused on other literary devices such as voice, style,
genre and so forth by simply substituting them in place of the
default terms. In the same way, this web can be converted for use
in the social studies curriculum by analyzing an historic event as
if it were a story. For instance, the Civil War can be seen as a
story of conflicts between the characters of two settings.
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Language Arts-Mythic Journey
The Mythic Journey

Part I

Once upon
a time ...

Protagonist
gets advice
from mentor

One day,

Part II

Starting
the
Journey

Tests,
Allies,
Enemies

Approach

Supreme
Ordeal

Part III

The return
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How to use this template
1

Enter events in the subsymbols associated with Part I. Open
Inspiration’s Notes text for further explanation of what to
write. To view Notes text, simply select the symbol by
clicking on it and click the Add Note button. You can also
add subsymbols as necessary using the Create tools.

2

Continue entering events in the subsymbols associated with
Part II. Consult Notes text for writing advice and add
subsymbols as necessary using the Create tools.

3

In Part III, enter event(s) that bring the story to its
conclusion, adding subsymbols as necessary using Create
tools.

Benefits of using the Mythic Journey template
This template will help students understand the archetypal
foundations of narrative. Use diagrams to analyze literature, or
as a basis for students to write their own myths, legends and so
forth.
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Language Arts-Persuasive
Persuasive
Essay

Introduction

State the facts

Give brief outline
of argument to
follow

Tell why
argument is
reasonable

Address
arguments of the
other side

Summarize your
arguments

How to use this template
1

Using information from brainstorm or first draft, enter
information into the appropriate subsymbols.

2

Add subsymbols as necessary using Create tools.

3

Check the Outline view to make sure that each area contains
sufficient information.

4

For writing help, see Notes text associated with each area of
the essay.

Benefits of using the Persuasive Essay template
This template will support students as they organize their ideas,
and help them to form logical arguments. The template will also
remind them of their audience and purpose as they construct
their essay.
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Language Arts-Poetic Analysis

Line 8

Line 1

Line 7

Line 2
Title of Poem
by
Author

Line 6

Line 5

Line 3

Line 4

How to use this template
1

Enter lines from the selected poem in the appropriate
symbol.

2

Add symbols as necessary using the Create tools.

3

Record interpretations, comments, questions, etc. in the
cloud symbols associated with each line.

4

Add subsymbols as necessary using the Create tools or
RapidFire feature.

Benefits of using the Poetic Analysis template
This template allows students to analyze or respond to a poem
line by line, making a sometimes daunting task more
manageable. By switching to Outline view, students will be able
to translate their diagram to the beginnings of an analytic essay.
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Language Arts-Vocabulary

Antonyms

VOCABULARY
WORD

Synonyms

People Who
Do This or
Who Are
This

How to use this template
1

Enter selected word in the symbol labeled “VOCABULARY
WORD.”

2

Enter appropriate text in the subsymbols or click on
Synonyms, Antonyms, etc. As you brainstorm, add symbols
as necessary using the Create or RapidFire tools.

Benefits of using the Vocabulary Web template
The Vocabulary Web allows students to examine and analyze a
verbal concept visually. After filling in the template, students
can see the entire information about their word at a glance, as
well as isolate specific details, such as antonyms, for
memorization. Other approaches to vocabulary enhancement
may be added as well, such as uses of the word in context, its
etymology, variant definition and so forth.
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Science-Concept
NEW
CONCEPT
Linking words

Linking words

Linking words
Linking words

Linking words

How to use this template
1

Type the concept to be mapped in the “NEW CONCEPT”
symbol.

2

Add new symbols for all you know about the subject using
Point&Type.

3

Use the Link tool to connect related concepts.

4

In the link's associated text box, type words that explain the
connections between the ideas.

Benefits of using the Concept Map template
A concept map is used to show relationships between ideas.
They can be used in any discipline to help analyze information,
chains of events, systems, subsystems and so forth. Concept
maps connect symbols with syntax so that meaning can be
constructed, understood and remembered both visually and
verbally.
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Science-Lab Report
Lab Report
Purpose

Procedure

Results

Conclusions

How to use this template
1

Enter purpose or goal of experiment in the symbol labeled
“Purpose.”

2

Enter each step of the experiment in the subsymbols
associated with “Procedure.” Add subsymbols as necessary
using Create tools.

3

Enter results and/or observations in the subsymbols
associated with “Results.” Add subsymbols as necessary using
Create tools.

4

Type the conclusions drawn from your results in the last
symbols.

Benefits of using the Lab Report template
Using this template will simplify the steps involved in writing a
lab report. It will also guarantee uniformity among student
papers for easier comparison.
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Science-Scientific Method
Scientific
Method

1

State the
Problem

2

Gather
Information

3

Form a
Hypothesis

4

Test the
Hypothesis

5

Draw
Conclusions

How to use this template
1

Type the steps taken while conducting a scientific inquiry
into the subsymbols associated with the appropriate stage of
the procedure.

2

Add subsymbols as necessary using the Create tools.

3

For additional help, read the notes associated with each step.

Benefits of using the Scientific Method template
Using a template such as this helps students understand scientific
method at the same time they are actually involved in it.
Student experiments will also be uniform in format, making
comparison easier.
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Science-Simple Cycles
Event leads
to...

How to use this template
1

Enter a cyclical event in the symbol labeled “Event leads
to....”

2

Enter subsequent events in the appropriate symbols.

3

Add symbols to represent additional events in the cycle using
the Create tools, or select a link and use the Insert Symbol
command from the Symbol menu.

Benefits of using the Simple Cycles Web template
This template can be used to show cycles and processes at a
simple level before going on to more complex, nonlinear
explanations. Although it is commonly used in the
sciences—nitrogen cycle, water cycle—this template can be used
in other disciplines. In language arts, students might use this
template to look at plot events of character growth. Social
studies topics such as inflation or westward movement might
also benefit from examination in this manner.
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Social Studies-Cause&Effect
We often find that one cause has several effects,

EFFECTS/RESULTS

EFFECTS/RESULTS

CAUSE

and that several causes lead to one effect.

CAUSE

EFFECT/RESULT

How to use this template
1

Enter any event in the symbol labeled “CAUSE.”

2

Enter initial effects of that event in the first set of
subsymbols.

3

Enter ensuing effects in the next set of subsymbols.

4

Add symbols as necessary using the Create or RapidFire
tools.

5

Automatically align your symbols by clicking the Arrange
button and choosing Right Tree.
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Benefits of using the Cause&Effect template
This approach is most often used in science and social studies. In
social studies, use this diagram to show the causes and effects of
wars, economic trends/crises, political movements and so forth.
It is also a valuable assessment tool to determine if students
understand various aspects of history curriculum, such as causes
and effects of the Civil War. In the sciences, use this tool to
illustrate chemical reactions, animal adaptation, changes in
migration patterns and so forth. Examination of cause/effect
relationships in language arts helps students construct logical
plot lines in fiction writing, examine life events for personal
essays and autobiographies, or analyze information for essays.
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Social Studies-Events

Group

Effect of
Event

Group

Group

How to use this template
1

Indicate a specific event in the symbol labeled “Effect of
Event.”

2

Enter the names of specific groups affected by the event in
the first set of subsymbols.

3

Enter examples of the effects as subsymbols.

4

Add groups and effects symbols as necessary using the Create
or RapidFire tools.

Benefits of using the Understanding Events Web
template
Often students see history as a series of events, dissociated from
the human condition. Students need to see that events affect
people internally as well as externally. The Understand Events
Web allows students to analyze the effects of an event from a
psychological perspective. This template can be used in science,
language arts and social studies curricula. For example, it is
possible to examine the effect of events such as the invention of
the printing press or the development of atomic energy.
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Social Studies-Historic Period

Human
Rights
Political
Events

Exploration
Historic
Period

Literature,
Music & Art

Inventions

How to use this template
1

Enter appropriate events into subsymbols associated with
human rights, exploration and so forth.

2

Add subsymbols as necessary using the Create tools.

Benefits of using the Historic Period template
Using this template will help students gain a broader view of
what is meant by the term “Historic Period.” Beginning with
this template may prompt students to explore possible
cause/effect relationships within historical context.
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Social Studies-History Web 1
What
immediately
precipitated
event

EVENT

Causes
leading
toward event

Factors
fighting
against
event

How to use this template
1

Enter any event in the symbol labeled “EVENT.”

2

Enter information about factors surrounding this event as
indicated by subsymbols.

3

Add more supporting information as necessary using the
Create or RapidFire tools.

Benefits of using the History Web 1 template
Use of this template allows students to conduct a more
sophisticated analysis of an event than a simple cause/effect
approach allows. Students will see a progression of causes, as well
as factors that might have reversed a particular chain of events.
This template can be used to analyze any event, historic,
current, ecological, literary and so forth.
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Social Studies-History Web 2

Foreign
Policy

Leader or
Country

Domestic
Policy

Economic
Ideas

How to use this template
1

Enter the name of a country or political figure, historical or
contemporary, in the appropriate symbol.

2

Enter information about foreign/domestic policies, and
economic ideas in the appropriate subsymbols.

3

Add symbols (e.g., reform programs, political stance and so
forth) as necessary using the Create tools.

Benefits of using the History Web 2 template
One of the basics of learning history is learning to think like an
historian. Students need to see that ideas, as well as actions, have
consequences. Towards this end, the History Web 2 template
allows students to analyze a political figure or country from a
policy perspective. This approach promotes a shift in focus
from concrete to abstract; that is, from events to the ideas that
might have fueled them.
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Teacher-Goal Setting
GOAL
SETTING

Name:

What I
already
do well

Areas to
develop

Time frame:

What I need
to do

Resources

How to use this template
1

Fill out this template in conference with individual students.
Prompt them to list things they do well and enter this
information in the subsymbols associated with “What I
already do well.” Add subsymbols as necessary using the
Create tools.

2

Repeat with “Areas to develop,” and “What I need to do.”

3

Help students determine where they can find help for each
problem, and list in the subsymbols associated with
“Resources.” Add subsymbols as necessary using the Create
tools.
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Benefits of using the Goal Setting Worksheet
template
Using this template lends concreteness to the goal setting
process. This template can be used for long term projects such as
research papers, completing missing assignments, meeting the
requirements of a specific grade and so forth. It is also a good
tool for helping students set learning goals for each reporting
period.
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Teacher-KWHL Strategy
?

What do you
Know?

What do you
Want to
Know?

Main Idea

How will
you find out?

What did you
Learn?

How to use this template
1

Type the main idea for an activity into the symbol labeled
Main Idea.

2

Solicit information from students reflecting what they
already know about the subject and type into the subsymbols
associated with the symbol labeled “What do you KNOW?”

3

Help students brainstorm a list of questions about the subject
that reflect what they want to know and type them into the
subsymbols associated with “What do you WANT to know?”

4

Help students brainstorm ways of answering their questions
and enter them into the subsymbols associated with “HOW
will you find out?”

5

As students research the topic, have them record answers to
their questions in the subsymbols associated with “What did
you LEARN?”

6

Add subsymbols as necessary using the RapidFire feature or
the Create tools.
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Benefits of using this template
The KWHL strategy helps students find purpose in their
learning endeavors. Organizing information and making the
process visible also helps them tap the schemas of prior
knowledge as they gain metacognitive skills.
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Teacher-Lesson Plan
1

2
Agenda

3

Class/
Section

In class
assignments

Lesson Plan
Activities

Date
Homework

Notes
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How to use this template
1

Enter date and name of class/section in the appropriate
symbols.

2

Enter agenda items, assignments, activities, notes and so
forth from your lesson plans into the subsymbols associated
with each.

3

Add subsymbols as necessary using the Create tools.

Benefits of using the Lesson Plan template
Keeping lesson plans in this way allows for consistency and easy
transfer of assignments into the “Makeup Work” and
“Substitute Lesson” templates. It also provides a way for
administrators to check and assimilate plans “at a glance.”
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Teacher-Makeup Work

Name

In class
assignments

While you
were under the
weather

Activities

Homework

Dates
gone:

How to use this template
1

Enter student’s name and the dates of absence in the
appropriate symbols.

2

Transfer in class and homework assignments, information
on activities and so forth from your lesson plans into the
subsymbols associated with each.

3

Add subsymbols as necessary using the Create tools.
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Benefits of using the Makeup Work template
Keeping track of assignments and other work missed by students
takes a great deal of time that could be spent more fruitfully.
Copying and pasting assignments and so forth from the Lesson
Plan template into the Makeup Work template not only saves
time but also ensures accuracy and consistency. Displaying
makeup work in this way allows students to see work at a glance
and, especially for visually oriented students, aid them in
remembering to do their assignments.
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Teacher-Progress Report
Attendance:

Punctuality:
Classroom
behavior

Citizenship:

Attention:
PROGRESS REPORT for:

Meeting
this term's
goals?

Missing
assignments?

What you
can do to
help at
home.
Request
conference
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How to use this template
1

Enter student’s name.

2

Describe student behavior in the appropriate subsymbols
associated with “Classroom behavior.”

3

Describe student’s progress in meeting goals in the
subsymbols associated with “Meeting this term’s goals.”

4

Copy descriptions of missing assignments from your lesson
plans and paste in the appropriate subsymbols.

5

Suggest ways parents can help in the subsymbols associated
with “What you can do to help at home?”

6

Add subsymbols as necessary using Create tools.

7

Indicate whether a conference is necessary.

Benefits of using the Progress Report template
This template is useful for both parents and their children to
determine ways in which progress can be made and behavior
modified. You may with to use it in conjunction with the Goal
Setting template.
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Teacher-Substitute Lesson

Class/
Section:

1

Item
One

2

Item
Two

3

Item
Three

Teacher
Agenda

Student
Agenda

Item
One

2

Item
Two

3

Item
Three

Please let me know
how things went
while I was out.
Thank you!

Substitute
Lesson Plan
Directions for
in- class
assignments

1

Notes from
Substitute

Date:
Directions
for
homework
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How to use this template
1

Enter date and name of class/section in the appropriate
symbols.

2

Enter teacher agenda items into the associated subsymbols.
These might include taking attendance, a list of student
handouts and so forth. Add subsymbols as necessary using the
Create tools.

3

Enter student agenda items into the associated subsymbols.
These items will describe what students should be doing, such
as writing in journal, turning in homework and so forth. Add
subsymbols as necessary using the Create tools.

4

Enter other directions, descriptions and so forth from your
regular lesson plan into the appropriate subsymbols. Add
subsymbols as necessary using the Create tools.

Benefits of using the Substitute Lesson template
This template allows for easy transfer of plans and assignments
from your regular lesson plan and provides a means of clear
communication with substitute teachers. The plan enables them
to check and assimilate your plans “at a glance.”
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Thinking-Brace Map

Main Idea

How to use this template
1

Type the object, concept, etc. to be analyzed in the Main
Idea symbol.

2

Type secondary components in the next level of subsymbols
labeled with numbers.

3

Continue to break down each of the secondary components
into parts using the symbols labeled with letters.

4

Add further levels of analysis as necessary using the Create
or RapidFire tools.

5

After adding symbols, use the Arrange tool to arrange the
diagram as a Right Tree.

Benefits of the Brace Map template
The Brace Map Template can be used to help students break
complex ideas and systems into component parts. It also allows
students to visualize and explore whole/part relationships, as well
as reinforcing skills in hierarchical arrangements.
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Thinking-Bridge Map

chicken

as

egg

Word 1

cow
?

as

Word 2

Word 3
Word 4

How to use this template
Enter words, concepts, processes and so forth into the text fields
labeled Word 1, 2, 3, 4 to demonstrate analogic comparisons.
(See example.)

Benefits of using the Bridge Map template
Although abstract reasoning processes such as analogic thinking
are important in numerous ways, they are difficult to explain to
students. Graphic representations of abstract relationships help
students understand connections and parallels between ideas.
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Thinking-Bubble Diagram

Bubble

Bubble

Bubble

Main Idea

Bubble

Bubble

Bubble

How to use this template
1

Type idea to be described in the Main Idea symbol.

2

Type descriptive words in the subsymbols.

3

Add subsymbols as necessary using RapidFire or the Create
tools.

Benefits of using the Bubble Diagram template
The Bubble Diagram is a simple way of defining the attributes of
any concept, character or system. Information may be added as
study progresses and new attributes are discovered.

Inspiration templates

115

Thinking-Circle Map

Placeholder
Placeholder

Placeholder

Placeholder

Main Idea

Placeholder

Placeholder

Placeholder

Placeholder

How to use this template
1

Enter any topic in the Main Idea symbol.

2

Enter related information in each of the subsymbols
surrounding the Main Idea.

3

Add more subsymbols as necessary using Point&Type.

Benefits of using the Circle Map template
Students can use this template to place an idea, movement or
event in context. Use of this template allows students to
conduct a more sophisticated analysis of an event than a simple
cause/effect approach allows.
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Thinking-Double Bubble

Idea 1

Idea 2

How to use this template
1

Enter any concept in the symbol labeled Idea 1.

2

Enter another concept for comparison in the symbol labeled
Idea 2.

3

Enter shared attributes in each of the middle subsymbols.
Note that these subsymbols should be linked to both Idea 1
and 2.

4

Enter attributes that are particular to Idea 1 and Idea 2 in
the outer subsymbols.

5

Add subsymbols as needed using Command (CTRL) click. If
you are adding a subsymbol in the middle, use the Link tool
to create the additional link.

Benefits of using the Double Bubble template
This template can be used to draw simple comparisons
(hero/villain, vertebrate/invertebrate, democracy/dictatorship
and so forth) or examine more complex subject matter (life
cycles, literary styles, subcultures, etc.).
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Thinking-Flow Diagram
Main Idea

How to use this template
1

Enter a process, sequence, timeline, etc. in the Main Idea
symbol.

2

Enter subsequent events in the appropriate symbols.

3

Add symbols to represent additional events using the Create
tools. To add a symbol between two existing symbols, select
a link and use the Insert Symbol command from the Symbol
menu.

Benefits of using the Flow Diagram template
Use this template to represent linear and/or concurrent events
and processes. Students can also demonstrate their understanding
of actions, steps, directions or cycles at a simple level before
going on to more complex, nonlinear explanations.
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Thinking-Goal Setting
Goal Setting Worksheet

Today's date:

!

My goal is:

!

1

What is the first step?

Target completion date:

2

What is the second major
step?

Target completion date:

3

What is the third major step?

Target completion date:

4

Next step?

Target completion date:

5

Final step?

Target completion date:

Completion date:

How to use this template
1

Type a goal in the symbol labeled “My goal is:”

2

Type the proposed completion date in the box labeled
“Completion date:”

3

Consider the steps involved in addressing the goal and type
them into numbered symbols. Add or delete symbols as
necessary.

4

Enter target completion dates in the appropriate symbols.
The target date corresponding to “Final step” should be the
same as the date in the “Completion date” symbol.

5

Adjust dates, steps as necessary to allow for reasonable
deadline completion.
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Benefits of using the Goal Setting Worksheet
template
Using this template lends concreteness to the goal setting
process. It also increases the likelihood of accomplishing goals
by naming and clarifying the steps involved, and determining a
time frame. This template can be used for long-term projects
such as research papers, completing missing assignments,
meeting the requirements of a specific grade and so forth.
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Thinking-Idea Map

Main Idea

Creating an Idea Map
1

Start with a central idea and type it into the Main Idea
symbol.

2

Brainstorm ideas branching from the central idea. To add
subsymbols, click the RapidFire button and press Return
(Enter) after each idea you type. Select unnecessary
subsymbols and delete.

3

Show relationships between branches with textured lines and
colors.

4

Leave your mind as free as possible.

5

Use key words to represent ideas.

Benefits of using an Idea Map
Idea mapping will help you explore an idea freely without the
constraints of a superimposed structure. Moreover, a visual
environment promotes making new connections and insights in
a way that linear text does not. Using the Outline view,
however, will allow you to arrange your ideas in a more
conventional, readable manner.
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Thinking-Interrelationship

Main Idea

How to use this template
1

Choose your goal statement and type it into the Main Idea
symbol.

2

Identify the major factors affecting this goal or problem and
enter them into subsymbols.

3

Additional symbols may be created using
Point&Type—symbols are automatically drawn to hold your
ideas.

4

Use the Link tool to show relationships between the ideas.

5

Count the number of out-arrows. The symbol with the most
out-arrows is the “Primary Driver.” Count in-arrows to
identify the “Primary Effect.”

Benefits of using the Interrelationship Diagram
template
The Interrelationship Diagram provides yet another way to
analyze goals and problems of all kinds. Visualizing them in this
way will support efforts to address them in a logical and
effective manner.
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Thinking-Multi-Flow Map

Main Idea

How to use this template
1

Enter the event to be examined in the Main Idea symbol.

2

Enter the causes of the event in the left subsymbols.

3

Enter the effects of the events in the right subsymbols.

Benefits of using the Multi-Flow Map template
This approach is most often used in science and language arts,
and is a valuable tool for demonstrating the inter-relatedness of
events. In the sciences, use this tool to illustrate chemical
reactions, animal adaptation, changes in migration patterns and
so forth. In language arts, examination of cause/effect
relationships helps students construct logical plot lines in fiction
writing, examine life events for personal essays and
autobiographies, or analyze information for essays.
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Thinking-Tree Diagram
Main Idea

How to use this template
1

Type the concept to be analyzed in the Main Idea symbol.

2

Type supporting ideas in the next level of subsymbols.

3

Continue to break down each of the supporting ideas and
record them in subsequent levels.

4

Add further levels of analysis as necessary using the Create
tools.

5

After adding symbols, use the Arrange tool to arrange as a
Top Down Tree.

Benefits of using the Tree Diagram template
The Tree Diagram template can be used to break complex ideas,
systems, etc. into component parts, allowing students to
visualize and explore whole/part relationships. It can also be used
to introduce or reinforce skills in hierarchical arrangements.
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Thinking-Venn Diagram

Ideas 1
Unique attributes:

Common
Idea 1 and
Idea 2
attributes:

Ideas 2
Unique attributes:

How to use this template
1

Select the text symbol in each circle. Type in the item being
compared and its unique attributes. In the text box in the
overlapping area of the circles, add the attributes the items
have in common.

2

To change the size of circles: Click on the circle, then
holding the Command (Ctrl) key, drag any corner handle.

3

To change the color of circles: Select the circle, click on the
Line Color on the bottom of the screen. Choose a new color
from the palette.

4

To create your own circles: Select the Circle from the Draw
toolbar on the bottom of the screen. Hold the Shift Key
while drawing.

Benefits of using the Venn Diagram template
This template can be used for simple comparisons: hero/villain,
vertebrate/invertebrate, democracy/dictatorship and so forth.
However, the template also supports much greater
sophistication and complexity, depending on the subject matter
and the user. For example, students might compare the subtle
similarities and differences between life cycles, literary styles,
subcultures and so forth.
Inspiration templates
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Appendix B—Inspiration Software, Inc. License
Agreement

IMPORTANT  PLEASE READ THIS LICENSE AGREEMENT
CAREFULLY BEFORE OPENING THE SOFTWARE PACKAGE:
By opening this Software package (package containing the CD), you agree to
be bound by the terms and conditions of this Agreement. If you do not agree
with these terms, promptly return the unopened Software package, along with
the rest of the package, to the place of purchase for a full refund.
This is a legal agreement between you, the end user, and Inspiration Software,
Inc. The enclosed computer program (“Software”) is licensed, not sold, to you
by Inspiration Software, Inc. for use under the terms of this license.
GRANT OF LICENSE: Inspiration Software, Inc. grants you the following
rights to the Software:
Single installation: You may install and use the Software on the temporary
memory or hard drive or other storage device of any single computer used by
one person at a time. You must license (purchase) an additional copy of the
Software for each additional computer on which you want to use it. You must
also license (purchase) additional copies of the software if the single
computer is being used in a server-based computing environment, which
allows multiple, concurrent users to run a single server.
Multiple licenses: If you have multiple Licenses of the Software, then at any
time you may have as many computers with the Software installed as you have
Licenses. You must license (purchase) an additional copy of the Software for
each additional computer on which you want to use it.
Ownership: You admit and agree to the validity and enforceability in all
respects of any copyright of Inspiration Software, Inc. You agree that you will
not participate in any attack on the validity or enforceability of any of the
present copyrights, or potential future copyrights of Inspiration Software, Inc.
whether in court, the United States Copyright Office, or elsewhere except as
may be required in response to a subpoena. All rights to the Software
(including but not limited to any images, photographs, animations, video,
audio, music, text, examples, templates, symbols and software modules
incorporated into the Software) are owned or licensed by Inspiration Software,
Inc. and are protected by the United States and International copyright laws
and International trade provisions.
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OTHER RESTRICTIONS: You may not:
a)

Reverse-engineer, disassemble, decompile, modify or create derivative
works of this software.

b)

Sublicense, rent, loan or lease any portion of the Software or
accompanying materials.

c)

Use the backup or archival copies of the Software (or allow someone else
to use such copies) for any purpose other than backup.

You may transfer the Software and the accompanying written materials to a
recipient provided you retain no copies and the recipient agrees to the terms
of this Agreement.
LIMITED WARRANTY: Inspiration Software, Inc. warrants that the media on
which the Software is recorded will be free of defects in materials and
workmanship under normal use for 90 days after the date of original purchase.
If a defect occurs during the 90-day period, you may return the media (disks or
CD) to Inspiration Software, Inc. for free replacement. Inspiration Software,
Inc. will replace the media, provided that you have previously returned the
product registration card accompanying the Software to Inspiration Software,
Inc. Any replacement Software will be warranted for the remainder of the
original warranty period or 30 days, whichever is greater. These remedies are
not available outside of the United States of America.
Inspiration Software, Inc. disclaims all other warranties, either express or
implied, including but not limited to implied warranties of merchantability
and fitness for a particular purpose, with respect to the product. This limited
warranty gives you certain legal rights. You may have others, which vary from
state to state. In no event will Inspiration Software, Inc. be liable to you for
damages, whether based on contract, tort, warranty or other legal or equitable
grounds, including any loss of profits, cost savings or other incidental or
consequential damages arising out of your use or inability to use the
Software, even if Inspiration Software, Inc. or an authorized representative of
Inspiration Software, Inc. has been advised of the possibility of such damage.
Inspiration Software, Inc. does not warranty that the Software will meet your
requirements or that the operation of the Software will be uninterrupted or
error-free.
GENERAL: This License will be construed under the laws of Oregon, except
for that body of law dealing with conflicts of law. If there is any dispute under
the present agreement, you consent to the jurisdiction and venue of all state
and federal courts of Oregon. If any provision of this License shall be held by
a court of competent jurisdiction to be contrary to law, that provision will be
enforced to the maximum extent permissible, and the remaining provisions of
this License will remain in full force and effect. If you are a U.S. Government
user, then the Software is provided with “RESTRICTED RIGHTS” as set forth
in the sub paragraphs c(1) and (2) of the Commercial Computer SoftwareRestricted Rights clause at FAR 52.277-19 or subparagraph c(1)(ii) of the
Rights in Technical Data and Computer Software clause at DFARS 252.2777013, as applicable.
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Index

+-Note button, 60
+-Sub button, 61
Add Note button, 59, 70
Add Sub button, 56
Add Topic button, 57
adding
subtopics, 56
topics, 57
Arrange button, 73
Arrange Entire Diagram, 74
Arrow Head Ending Point command, 78
arrow heads
with links, 48, 78
Auto-90, 74
colors
changing, 76
multicolor symbols, 77
concept map, 24
example, 24
conventions, 31
copying
symbol libraries, 11
templates, 11
customer service, 19
customer support, 19
defaults
new settings, 71
Diagonal Create button, 39
Diagram button, 69
Diagram toolbar
Add Note button, 70
Arrange button, 73
Diagonal Create button, 39
Horizontal and Vertical
Create button, 38
Link button, 48
New Look button, 72
Outline button, 55
Position button, 45
Diagram view
automatically opens, 34
defined, 22

Index

notes text, 70
window, 22
diagrams
defined, 32
hierarchical, 24
positioning in window, 45
printing, 80
rearranging, 73
saving, 36
types, 23
documents, 29
dragging and dropping, 46
Edit menu, 71
environments
Inspiration, 22
Fit To Window command, 75
Format menu, 71
Help, 5
Horizontal and Vertical Create button, 38
idea map, 25
example, 25
ideas
organizing, 21
Inspiration
and serial number, 15
customer service, 19
customer support, 19
icon, 29
introducing, 21
menu item, 29
opening, 33
registering, 16
starting, 13, 15, 29
technical support, 19
templates, 81
tutorial, 31
lesson 1, 33
lesson 2, 37
lesson 3, 46
lesson 4, 54
lesson 5, 68
upgrading, 11
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User's Manual, 5, 17
views, 22, 54. See Diagram view or
Outline view
window
introducing, 34
installation requirements, 10
installing Inspiration
and serial number, 15
Macintosh, 12
networks, 12, 13
Windows, 13
Introduction, 21
keystrokes
zooming, 44
knowledge mapping, 24
lessons. See tutorial
lines
colors, 76
Link button, 48
links, 48
arrow heads, 78
color, 78
defined, 37
text, 50
Lowest Level Stacking Models, 74
Macintosh
installing Inspiration, 12
opening Inspiration, 29, 33
using Inspiration on, 31
main idea
entering, 35
placeholder text, 35
maps
in Diagram view, 22
Multicolor button, 77
multicolor symbols, 77
networks
and installing Inspiration, 12, 13
New Look button, 72
notes
adding, 58
hiding and showing, 60
in Diagram view, 70
in Outline view, 28, 70
opening window, 70
printing, 8
notes text
printing, 80
online Help, 5
opening Inspiration, 29
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Outline button, 55
Outline Properties, 64
Outline toolbar
+-Note button, 60
+-Sub button, 61
Add Note button, 59
Add Sub button, 56
Add Topic button, 57
Diagram button, 69
Prefix button, 63
Right button, 58
Outline view, 55
defined, 22
notes, 70
window, 23
outlines
changing prefixes, 63, 64
defined, 32
organizing, 55
printing, 65
uses, 28
Paste New Look command, 72
point and type, 47
Position button, 45
Prefix button, 63
prefixes
changing, 63
primary symbol, 48
Print Preview command, 80
printing, 65, 80
notes text, 8, 80
User's Manual, 17
Properties
outline view, 64
RapidFire button
using, 41
registering Inspiration, 16
reports
in Outline view, 22, 28
Right button, 58
Save command, 36
saving, 45
secondary symbols, 48
Select command, 71
serial number
location, 15
Start button, 29
starting Inspiration, 13, 14, 15, 29
and serial number, 15
Status bar, 51
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stories
in Outline view, 28
storyboard, 27
example, 27
subtopics
adding, 56
hiding and showing, 61
symbol libraries
copying, 11
Symbol palette, 46
symbols
adding, 72
dragging and dropping, 46
point and type, 47
changing, 52
colors
fill, 76
line colors, 76
links, 48
moving, 51
new look setting, 72
system requirements, 10
technical support, 19
templates
copying, 11
guide to, 81
text
and links, 50
correcting in symbols, 43
fonts, 64, 71
inserting in symbols, 43
Top Down Tree, 74
topics

Index

adding, 57
levels, 58
moving, 61
notes text, 58
tree charts, 73
tutorial, 31
lesson 1, 33
lesson 2, 37
lesson 3, 46
lesson 4, 54
lesson 5, 68
upgrading Inspiration, 11
User's Manual, 5
printing, 17
viewing, 17
views
scaling, 44
switching, 68
visual learning, 21
web, 26
example, 26
Windows 95/98
installing Inspiration, 13
opening Inspiration, 29, 33
Programs menu, 29
Start button, 29
using Inspiration on, 31
Zoom command, 75
Zoom In button, 44
Zoom Out button, 44
zooming
in diagrams, 44
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